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FAQ เกี่ยวกับระบบ eMENSCR 

❖ การใช้งานระบบ eMENSCR (อีเมนซ์) 

ค าถาม ค าตอบ 

ระบบ eMENSCR ใช้งานอย่างไร/ผ่าน
ช่องทางใด 

หน่วยงานสามารถเข้าใช้งานระบบผ่านทางเว็บไซต์ 
emenscr.nesdc.go.th โดยการ log in ด้วย username และ 
password ส าหรับเข้าระบบอีเมนซ์ของหน่วยงาน 

ใครได้รับ username การเข้าใช้งานระบบ 
eMENSCR จาก สศช. บ้าง 

• หน่วยงานภาครัฐ 
• วุฒิสภา และคณะกรรมาธิการ 
• หัวหน้าฝ่ายตุลาการ องค์กรอิสระ และองค์กรอัยการ 

ใครสามารถใช้ประโยชน์จากระบบ 
eMENSCR ได้บ้าง 

• หน่วยงานภาครัฐ 
• วุฒิสภา และคณะกรรมาธิการ 
• หัวหน้าฝ่ายตุลาการ องค์กรอิสระ และองค์กรอัยการ 
• ประชาชน 

ระบบ eMENSCR มีประโยชน์อย่างไร • ทุกส่วนราชการสามารถใช้ระบบในการติดตาม ตรวจสอบ และ
ประเมินผล นโยบาย แผนงาน โครงการภาครัฐ (One Report) 
บน platform เดียวกัน 

• สนับสนุนระบบ paperless มุ่งสู่ Digital Government 
• มีช่องทางให้ประชาชนมีส่วนร่วมในการติดตามและตรวจสอบ

การด าเนินงาน/โครงการของหน่วยงานภาครัฐ 
• เป็นระบบฐานข้อมูลกลางที่ เชื่อมโยงข้อมูลจากส่วนราชการ

ต่าง ๆ ได้อย่างบูรณาการ สามารถช่วยลดภาระการให้ข้อมูล
เพ่ือประกอบการชี้แจงต่าง ๆ ของหน่วยงานได ้

การน าเข้าข้อมูลโครงการในระบบ 
eMENSCR สามารถท าได้ในช่วงใดบ้าง 

หน่วยงานจะสามารถน าเข้าข้อมูลโครงการใหม่ ได้ในช่วงไตรมาส
แรกของปีงบประมาณ หากเป็นโครงการระหว่างปีจะต้องน าเข้า
ในช่วงเดือน ม.ค. / เม.ย. / ก.ค. เท่านั้น 

ระบบเปิดให้รายงานความก้าวหน้าของ
โครงการรายไตรมาสในช่วงใดบ้าง 

ไตรมาสที่ 1 (1 ต.ค. - 30 ธ.ค.) รายงานภายในวันที่ 1-30 ม.ค. 
ไตรมาสที่ 2 (1 ม.ค. - 30 มี.ค.) รายงานภายในวันที่ 1-30 เม.ย. 
ไตรมาสที่ 3 (1 เม.ย. - 30 มิ.ย.) รายงานภายในวันที่ 1-30 ก.ค. 
ไตรมาสที่ 4 (1 ก.ค. - 30 ก.ย.) รานงานภายในวันที่ 1-30 ต.ค.  
(รายงานภายในระยะเวลา 30 วัน หลังสิ้นสดุไตรมาส) 
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❖ การใช้งานระบบ eMENSCR (อีเมนซ์) 

ค าถาม ค าตอบ 

การน าเข้าข้อมูลโครงการในระบบ 
eMENSCR ท าอย่างไร 

1. เข้าสู่ระบบด้วย URL : emenscr.nesdc.go.th 

2. กรอก username และ password เพ่ือ log in เข้าสู่ระบบ 

3. เลือกปุ่ม “เพิ่มโครงการ” ในแถบเมนูซ้ายมือ 

4. เลือกปุ่ม “โครงการที่ได้รับการจัดสรรงบประมาณแล้ว” เพ่ือ
น าเข้าข้อมูลโครงการ 

➢ กรณีหน่วยงานมีการปรับโครงสร้าง
องค์กร จะต้องด าเนินการอย่างไร 

➢ กรณีหน่วยงานลืม Password ในการเข้า
ใช้ระบบ จะต้องด าเนินการอย่างไร 

1. หากท่านเป็นหน่วยงานภายใต้ก ากับของกระทรวง ให้ท่านติดต่อ
ประสานงานไปยัง Admin ที่เป็นผู้บริหารจัดการข้อมูลของผู้ใช้ใน
ระบบ eMENSCR ของกระทรวงต้นสังกัดนั้น ๆ เพ่ือให้ด าเนินการ 
ปรับปรุงแก้ไขข้อมูลให้ 

2. หากท่านเป็นหน่วยงานอิสระ หน่วยงานขึ้นตรงต่อนายกรัฐมนตรี 
หน่วยงานในสังกัดส านักนายกรัฐมนตรี หน่วยงานของรัฐสภา 
ศาล และหน่วยงานอ่ืน ๆ ที่ไม่ได้สังกัดกระทรวงใด ให้ท่านติดต่อ  
Admin ที่เป็นผู้บริหารจัดการข้อมูลผู้ใช้ในระบบ eMENSCR ของ
หน่วยงานของท่านเอง เพ่ือให้ด าเนินการให้   

3. หรือติดต่อมาที่ สศช. เพ่ือแจ้งรายละเอียดของหน่วยงานที่ต้องการ
ขอปรับปรุงแก้ไข โดยแจ้งรายละเอียดให้ครบถ้วน และส่งข้อมูล 
มาที่ emenscr@nesdc.go.th   

กรณีหน่วยงานต้องการขอ Username และ 
Password ส าหรับกอง/ฝ่ายที่จัดตั้งใหม่ต้อง
จะต้องด าเนินการอย่างไร 

ให้หน่วยงานติดต่อมาที่  สศช. เพ่ือแจ้งรายละเอียดของ
หน่วยงานที่ต้องการขอ Username และ Password โดยกรอก
แบบฟอร์มและแจ้งรายละเอียดให้ครบถ้วน และส่งอีเมลมาที่ 
emenscr@nesdc.go.th  และสามารถดาวน์โหลดเอกสารได้ที่ 
http://nscr.nesdc.go.th/emenscr-main/ 

➢ ในระบบ eMENSCR จ าเป็นต้องกรอกทุก
โครงการในแผนปฏิบัติราชการ หรือเฉพาะ
โครงการที่สอดคล้องกับยุทธศาสตร์ชาติกับ
แผนแม่บทฯ เท่านั้น 

➢ โครงการที่ไม่ใช้งบ ต้องน าเข้าระบบหรือไม่ 

การน าเข้าโครงการในระบบ eMENSCR ให้น าเข้าทุกโครงการ 
ที่หน่วยงานจะด าเนินการในปีงบประมาณนั้น ๆ ทั้ งที่ ใช้
งบประมาณและไม่ใช้งบประมาณ และต้องมีความสอดคล้อง 
กับยุทธศาสตร์ชาติและแผนแม่บทภายใต้ยุทธศาสตร์ชาติ  

การรายงานความก้าวหน้าในระบบ eMENSCR 
ท าอย่างไร 

 

1. เข้าสู่ระบบด้วย URL : emenscr.nesdc.go.th 

2. กรอก username และ password เพ่ือ log in เข้าสู่ระบบ 

3. เลือกปุ่ม “รายงานความก้าวหน้า” ในแถบเมนูซ้ายมือ 
 

http://nscr.nesdc.go.th/emenscr-main/
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❖ การใช้งานระบบ eMENSCR (อีเมนซ์) 

ค าถาม ค าตอบ 

4. จะปรากฏหน้าแสดงข้อมูลรายชื่อโครงการ / การด าเนินงาน
ที่ต้องรายงานความก้าวหน้า 

5. เลือกปุ่มฟันเฟือง ในช่องจัดการโครงการ และเลือก 
“รายงานความก้าวหน้ารายไตรมาส” 

สามารถท าการแก้ไขรายงานความก้าวหน้า 
รายไตรมาสที่กดส่งอนุมัติไปแล้ว ได้หรือไม่ 

1. ในกรณีที่การรายงานรายไตรมาสมีสถานะ “อนุมัติแล้ว”  
จะไม่สามารถแก้ไขข้อมูลได้  

2. ในกรณีที่การรายงานรายไตรมาสมีสถานะเป็น “บักทึกร่าง
รายงานฯ” หน่วยงานยังสามารถแก้ไขได้ โดยกดที่
ปุ่มฟันเฟือง และเลือกรายงานรายไตรมาส ที่ต้องการแก้ไข 

3. ในกรณีที่การรายงานรายไตรมาส มีสถานะอยู่ระหว่างการ 
“รออนุมัติ”  หน่ วยงานสามารถประสานไปยั ง
ผู้บริหารที่ เป็นผู้อนุมัติ  ให้ช่ วยกด reject (ไม่อนุมัติ )  
การรายงานรายไตรมาสในระบบ เพ่ือที่การรายงานจะถูก 
ตีกลับมายังผู้น าเข้าข้อมูล และสามารถท าการแก้ไขได้ 

เหตุใดในหน้ารายงานความก้าวหน้า จึงไม่
ปรากฏโครงการให้รายงานความก้าวหน้า  
ทั้งที่ตัวโครงการมีสถานะเป็นอนุมัติแล้ว 

ในระบบจะปรากฏโครงการให้รายงานความก้าวหน้า เมื่อถึง
ช่วงเวลาของการเริ่มต้นโครงการ ที่ผู้น าเข้าข้อมูลระบุไว้ 
ในส่วนของรายละเอียดหัวข้อระยะเวลาด าเนินโครงการ/ 
การด าเนินงาน (M3) 

เมื่อโครงการ/การด าเนินงานผ่านการอนุมัติ
ข้อมูลโดยผู้บังคับบัญชา (M7) จะสามารถ
แก้ไขรายละเอียดโครงการได้หรือไม่ 

 

หากโครงการ/การด าเนินงานผ่านการอนุมัติโดยผู้บังคับบัญชา 
ทั้งหมดแล้ว จะไม่สามารถแก้ไขรายละเอียดได้ ยกเว้นกรณี 
ที่มีความจ าเป็น  อาทิ เป็นโครงการ ณ ปีปัจจุบัน ที่ลงปี 
งบประมาณผิด หรือลงงบประมาณผิด 

โดยจะต้องท าหนังสือทางการส่งมายัง สศช. เพ่ือขอแก้ไข
โครงการในระบบ โดยจะต้องแจ้งชื่อโครงการ รหัสโครงการ  
และ username ที่น าเข้าข้อมูลโครงการ ส่งมาถึง ผอ.กอง
ยุทธศาสตร์ชาติและการปฏิรูปประเทศ  

(หมายเหตุ : หากเป็นข้อมูลทั่วไปที่ ไม่ใช่สาระส าคัญของ
โครงการ จะไม่เปิดให้แก้ไข แต่จะให้หน่วยงานเข้าไปรายงาน
ผลตามข้อเท็จจริง โดยระบุไว้ในส่วนของปัญหา/อุปสรรค) 
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❖ การใช้งานระบบ eMENSCR (อีเมนซ์) 

ค าถาม ค าตอบ 

องค์กรปกครองส่วนท้องถิ่นต้องกรอกข้อมูล
โครงการเข้ามาในระบบ  eMENSCR ด้วย
หรือไม่ 

หากเป็นโครงการที่ใช้งบประมาณของท้องถิ่นเอง ให้กรอกผ่าน
ระบบ e-plan เช่นเดิม ไม่ต้องกรอกในระบบ eMENSCR   
ยกเว้นในกรณีที่ อปท. ได้รับงบประมาณจากจังหวัดหรือกลุ่ม
จังหวัดมาด าเนินโครงการ ซึ่ง อปท. จะต้องเป็นผู้น าเข้าข้อมูล
โครงการในระบบ eMENSCR ด้วยตนเอง โดยหน่วยงาน
สามารถท าหนั งสื อแจ้ งขอ  username และ password 
ส าหรับเข้าระบบ eMENSCR มายัง สศช. เพ่ือกรอกโครงการ 
ที่ได้รับงบจากจังหวัดหรือกลุ่มจังหวัด โดยกรอกแบบฟอร์ม 
และแจ้ งร ายละ เอี ย ด ให้ ค รบ ถ้ วน  แล ะส่ ง อี เม ลม าที่ 
emenscr@nesdc.go.th ซ่ึงสามารถดาวน์โหลดเอกสารได้ท่ี 
http://nscr.nesdc.go.th/emenscr-main/  

ข้อมูลแผนงาน/โครงการของ อปท. จากระบบ  
e-Plan จะปรากฏในระบบ eMENSCR ด้วย
หรือไม่ 

โครงการของ อปท. มีการแสดงผลในระบบ eMENSCR ด้วย  
ซึ่งโครงการแต่ละปีงบประมาณของ อปท. จะมีการน าเข้า
ข้อมูลในระบบ eMENSCR ในช่วงสิ้นปีงบประมาณนั้น ๆ ทั้งนี้ 
ผู้ที่สนใจสามารถเรียกดูข้อมูลโครงการของ อปท. ได้ ผ่านเมนู
โครงการทั้งหมดในระบบ 

หน้าสารบัญ ในระบบ eMENSCR มีข้อมูล
อะไรบ้าง 

ในหน้าสารบัญของระบบ eMENSCR มีข้อมูล ดังนี้ 

1. ข้อมูลโครงการที่ส่วนราชการบันทึกเข้าในระบบ 
eMENSCR ในรูปแบบไฟล์ JSON 

2. ข้อมูลแผนทุกระดับที่ใช้งานบนระบบ eMENSCR 
3. ข้อมูลแสดงผลการด าเนินการ (Dashboard) ตามเป้าหมาย

และตัวชี้วัดของแผนแม่บทภายใต้ยุทธศาสตร์ชาติ 
4. ข้อมูลโครงการที่มีสถานะเป็น “อนุมัติแล้ว” ทั้งหมดในระบบ 
5. ระบบวิเคราะห์ความคล้ายของโครงการด้วยเทคโนโลยี AI 
6. ข้อมูลจ านวนโครงการจ าแนกตามสถานะการอนุมัติโครงการ

และหน่วยงาน 
7. หน้าสรุปจ านวนโครงการจ าแนกตามด้านของยุทธศาสตร์ชาติ

และหน่วยงาน / จ าแนกตามประเด็นของแผนแม่บทภายใต้
ยุทธศาสตร์ชาติและหน่วยงาน / จ าแนกตามแผนการปฏิรูป
ประเทศและหน่วยงาน 

8. หน้าสรุปจ านวนโครงการตามความสอดคล้องของโครงการ
ต่อยุทธศาสตร์ชาติและแผนแม่บทภายใต้ยุทธศาสตร์ชาติ 

9. หน้าสรุปจ านวนโครงการตามความสอดคล้องของโครงการ
ต่อยุทธศาสตร์ชาติและแผนการปฏิรูปประเทศ 

http://nscr.nesdc.go.th/emenscr-main/
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❖ การใช้งานระบบ eMENSCR (อีเมนซ์) 

ค าถาม ค าตอบ 

10. หน้าสรุปจ านวนโครงการจ าแนกตามเป้าหมายแผนแม่บท
ย่อย 140 เป้าหมาย 

11. หน้าแสดงรายชื่อโครงการภายใต้ พ.ร.ก.เงินกู้ฯ ทั้งหมด 

12. หน้าแสดงงบประมาณรวมและจ านวนแผนงาน/โครงการ 
ของโครงการภายใต้ พ.ร.ก.เงินกู้ฯ 

หน้าสารบัญ ในระบบ eMENSCR มีประโยชน์
อย่างไร 

ผู้ ใช้สามารถเลือกใช้  Fuction ได้อย่างสะดวกตามความ
ต้องการใช้งาน เพ่ือน าข้อมูลไปประยุกต์ใช้ให้สอดคล้องกับ
ภารกิจของหน่วยงาน รวมทั้งสามารถน าข้อมูลไปวิเคราะห์ 
ประมวลผล หรือติดตามเร่งรัดการด าเนินการภายในหน่วยงาน
ได้อย่างเหมาะสม ทั้งนี้เพ่ือเป็นการพัฒนาต่อยอดการน าข้อมูล
ในระบบไปใช้ให้เกิดความคุ้มค่า และเกิดประโยชน์สูงสุด 

หน้าสารบัญ ในระบบ eMENSCR ใช้งาน
อย่างไร 

1. เข้าสู่ระบบด้วย URL : emenscr.nesdc.go.th 

2. กรอก username และ password เพ่ือ log in เข้าสู่ระบบ 

3. เลือกปุ่ม “สารบัญ” ในแถบเมนูซ้ายมือ 

4. เลือกดูข้อมูลที่ต้องการใช้งาน 
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❖ แผนระดับ 3 ในระบบ eMENSCR 

ค าถาม ค าตอบ 

ดูข้อมูลแผนระดับ 3 ในระบบ eMENSCR
อย่างไร 

1. เข้าสู่ระบบด้วย URL : emenscr.nesdc.go.th 

2. กรอก username และ password เพ่ือ log in เข้าสู่ระบบ 

3. เลือกปุ่ม “แผนระดับสาม” ในแถบเมนูซ้ายมือ 

4. จะปรากฏหน้าแสดงข้อมูลรายชื่อแผนระดับสาม ซึ่งสามารถ
เข้าดูข้อมูล น าเข้าแผน และรายงานผลสัมฤทธิ์ได้ 

ใครมีสิทธิ์น าเข้าข้อมูลแผนระดับ 3 ในระบบ 
eMENSCR ได้บ้าง 

ผู้ที่สามารถน าเข้าแผนระดับ 3 คือ ผู้ใช้ username ของกอง
แผน/กองยุทธศาสตร์ หรือส่วนงานที่ได้รับมอบหมายของแต่ละ
หน่วยงานเท่านั้น  

การน าเข้าแผนระดับ 3 ในระบบ eMENSCR 
ท าอย่างไร 

1. ผู้ ที่ ส ามารถน า เข้ าแผนระดั บ  3  คื อ  กองแผน /กอง
ยุทธศาสตร์ หรือส่วนงานที่ ได้รับมอบหมายของแต่ละ
หน่วยงาน 

2. การน าเข้าแผนระดับที ่ 3 ในระบบ อยู ่ในแถบเมนูทาง 
ด้านซ้ายมือ ในหัวข้อ “แผนระดับสาม” โดยหน่วยงาน
สามารถดาวน์โหลด Template ของแผนระดับที่ 3 ได้ที่   
http://nscr.nesdc.go.th/planlevel3/ เพ่ือเตรียมข้อมูล 
ในการกรอกเข้าระบบ 

3. การกรอกข้อมูลของแผนระดับ 3 เข้าระบบ หน่วยงาน
สามารถ  Upload ไฟล์ เล่ มแผนระดับ  3 เข้ าระบบได้  
โดยระบบรองรับเอกสารรูปแบบ pdf เท่านั้น 

4. เมื่อกรอกข้อมูลและอัพโหลดไฟล์เอกสารเรียบร้อยแล้ว  
ให้กดปุ่ม “บันทึก” 

5. กดปุ่มฟันเฟือง และเลือก “ส่งข้อมูล” เพ่ือท าการขออนุมัติ
ตามสายบังคับบัญชา (M7) 

 

  

http://nscr.nesdc.go.th/planlevel3/
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❖ ข้อมูล JSON ในระบบ eMENSCR 

ค าถาม ค าตอบ 

JSON คืออะไร ไฟล์ JSON เป็นไฟล์ที่มีการเก็บข้อมูลในรูปแบบ text ที่สามารถ
น าไปใช้งานต่อได้หลากหลายรูปแบบ โดยการน าไฟล์ไปประมวล 
ผลด้วยคอมพิวเตอร์ต่อได้ทันที (Machine readable) ท าให้ 
ง่ายต่อการใช้งาน และมีความรวดเร็ว ในการดึงข้อมูลมาใช้   
ซ่ึงประเภทข้อมูลที่ไฟล์ JSON สามารถเก็บได้ มีดังนี ้

• String - ตัวอักษร หรือ ตัวเลข (ไม่สามารถค านวณได้)  
            อยู่ในเครื่องหมาย (“_”) 

• Number - ตัวเลข (สามารถค านวณได้) 
• Object - หน่วยข้อมูลในไฟล์ JSON 
• Array - ข้อมูลที่ถูกจัดเก็บเป็นชุดข้อมูล 
• Boolean - True or False 
• Null - ไม่มีค่า (ค่าว่าง) 

JSON ใช้อย่างไร หน่วยงานสามารถดาวน์โหลดข้อมูลที่ต้องการในรูปแบบไฟล์ 
JSON ได้จากระบบ eMENSCR โดยเลือกปุ่ม “สารบัญ” 
ในแถบเมนูซ้ายมือ และเลือกข้อมูลที่ต้องการ ทั้งนี้สามารถ
เปิดไฟล์ JSON ด้วยโปรแกรมที่แนะน า ดังนี้ 

1. การเปิดไฟล์ JSON ผ่านโปรแกรม Dadroit 
- เปิดโปรแกรม Dadroit จากนั้นกด File > Open > เลือก

ไฟล์ JSON ที่ดาวน์โหลดมา > กด Open > 
จะปรากฏข้อมูลที่ต้องการอ่านผ่านโปรแกรม 
Dadroit 

2. การเปิดไฟล์ JSON ผ่าน Power Query โปรแกรม Excel 
- เปิดโปรแกรม Excel คลิ ก Data > Get Data > From 

File > From JSON > จะปรากฏข้อมูลที่
ต้ องการอ่านผ่ านโปรแกรม  Excel ทั้ งนี้
สามารถศึกษาวิธีการใช้งานเพ่ิมเติมได้ดังนี้ 

3. การเปิดไฟล์ JSON ผ่านโปรแกรม Python 
- โปรแกรม Python มีการเขียนภาษามีความเป็นระเบียบ 

ซึ่งผู้ใช้จ าเป็นต้องมีความรู้พ้ืนฐานในภาษาคอมพิวเตอร์ 
ดังนั้น การใช้งานจ าเป็นต้องเขียนภาษาคอมพิวเตอร์ 
เพ่ือเปิดอ่านข้อมูลไฟล์ JSON โดยสามารถ
ศึกษาวิธีการใช้งานเพ่ิมเติมได้ดังนี้  
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❖ โครงการเพื่อขับเคลื่อนการบรรลุเป้าหมายตามยุทธศาสตร์ชาติ ประจ าปี
งบประมาณ (โครงการส าคัญประจ าปีงบประมาณ) 

ค าถาม ค าตอบ 

ข้อเสนอโครงการส าคัญประจ าปีงบประมาณ 
ทีผ่่านการคัดเลือก เมื่อถึงปีงบประมาณที่
จะต้องด าเนินการ จะต้องน าข้อมูลโครงการ
เข้าระบบอีกครั้งหรือไม่ 

หน่วยงานจะต้องน าเข้าโครงการที่ผ่านการคัดเลือก ใหม่อีกครั้ง 
ในปีงบประมาณที่ต้องเริ่มด าเนินการ และท าการส่งอนุมัติตาม
สายบังคับบัญชา (M7)  

ความหมายของสถานะตามสัญลักษณ์รูปดาว 
หลังโครงการฯ ต่างกันอย่างไร 

ความหมายของสถานะตามสัญลักษณ์ มีดังนี้ 

 
 

 

 


